Elements of the Online Classroom
Reference Guide

Contents
Before You Begin ........................................................................................................................................... 2
Getting Started .............................................................................................................................................. 2
  Testing your audio and video settings ...................................................................................................... 4
Elements of the Online Classroom ................................................................................................................ 5
  Whiteboard ............................................................................................................................................... 5
    Whiteboard options .............................................................................................................................. 5
  Tools menu ................................................................................................................................................ 6
  + (Add apps) .............................................................................................................................................. 7
  Live audio/video window .......................................................................................................................... 8
    Reacting to audio/video material ......................................................................................................... 8
  Chat window ............................................................................................................................................. 8
    Public chat ........................................................................................................................................... 9
    Ask a question to the host .................................................................................................................... 9
Configuration menu .................................................................................................................................. 9
  People ................................................................................................................................................. 10
  Layout ................................................................................................................................................ 11
  Settings .............................................................................................................................................. 12
  Alerts ................................................................................................................................................... 13
  Exit ....................................................................................................................................................... 14
About This Document ................................................................................................................................. 14
Before You Begin
The online classroom is a video conferencing platform that allows teachers and students to interact using learning materials such as PPTs, PDFs, audio files, video files, quizzes, and more through the online whiteboard. Everything happens in real-time and provides the students with an experience very close to traditional face-to-face teaching.

The online classroom is where most of your interaction with students will occur, so it’s important that you know about all the functionality available, and that you are comfortable using it.

Getting Started
1. Log into the Intercambio Learning System (ILS).

Figure 1 Merithub Dashboard

2. Click the large Intercambio icon.

Result: The Intercambio dashboard opens.

Figure 2 Intercambio Dashboard

3. Click Sessions.

Result: The Sessions window opens.
4. In the session you’re configuring the online classroom for, click **View**.

Result: A screen with session details and links for recipients displays.

5. Click **Go to Session**.

Result: A screen with controls for testing your camera and microphone settings opens.
Testing your audio and video settings
The screen that displays shows your current default settings for audio input, audio output, and video input.

- If the Bandwidth and Jitter settings are acceptable, click **Skip this step** to accept the default settings and open the online classroom.
- To change any of the settings, click on the arrow at the end of the default setting entry to display alternative settings. Click **Save Settings** to accept the new settings and open the online classroom.
Elements of the Online Classroom
The first time you open the classroom for a session, what you see will be blank like this.

IMPORTANT—After you make changes/customize/configure to your teaching style, ILS saves your changes. Any tabs you left open the last time you were in the program will remain just as you left them.

Figure 5 Online Classroom—Initial View

1. Whiteboard
2. Tools menu
3. + (Add apps)
4. Live audio/video window
5. Chat window
6. Configuration menu

Whiteboard
Board–1 is the default whiteboard that displays when you open the online classroom for the first time. Use the Tools menu (2) to add content to this whiteboard.

Whiteboard options
Click the down arrow at the right edge of the top tab to display a drop-down menu of whiteboard properties:

- Click **Rename** to change the name of the whiteboard.
- Click **Prevent Deletion** to protect the whiteboard from accidental deletion. When selected, toggles with Allow Deletion.
- Click **Prevent Editing** to protect the whiteboard from accidental editing. When selected, toggles with Allow Editing.
- Click **Save As** to open a dialog box where you can rename the whiteboard and/or save it to a predetermined folder.
- Click **Assign to All** to query students with a multiple-choice question or written assignment.
- Click **Close** to close this whiteboard tab.
Tools menu
The Tools menu is anchored to the left edge of the online classroom window. Table 1 describes the tools available for sharing information on the whiteboard and other applications within the online classroom.

Table 1 Tools

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Selector icon" /></td>
<td>The <strong>Selector</strong> tool allows you highlight/choose elements in the online classroom.</td>
</tr>
<tr>
<td><img src="image" alt="Pencil icon" /></td>
<td>Use the <strong>Pencil</strong> tool to write on the whiteboard or other elements of the online classroom.</td>
</tr>
<tr>
<td><img src="image" alt="Highlighter icon" /></td>
<td>Use the <strong>Highlighter</strong> tool to emphasize elements on the whiteboard or other elements of the online classroom.</td>
</tr>
<tr>
<td><img src="image" alt="Settings icon" /></td>
<td>Click the <strong>Pencil Settings</strong> control to open a menu to customize the look of the Pencil and Highlighter tools.</td>
</tr>
<tr>
<td><img src="image" alt="Text icon" /></td>
<td>Use the <strong>Text</strong> tool to add text to the whiteboard or other elements of the online classroom.</td>
</tr>
<tr>
<td><img src="image" alt="Add Image icon" /></td>
<td>Use the <strong>Shapes</strong> control to open a menu for adding images, equations, shapes, lines, arrows and emojis, among other things, to customize the online classroom display. The <strong>Add Image</strong> (camera) icon opens a menu allowing you to select an image from your own uploaded images or from the preloaded Open Images library.</td>
</tr>
<tr>
<td><img src="image" alt="Erasing Tool icon" /></td>
<td>Use the <strong>Erasing Tool</strong> to remove elements of the whiteboard or online classroom display that you no longer want.</td>
</tr>
</tbody>
</table>
Use the **Undo** tool to undo your most recent action in the online classroom. Clicking this tool multiple times will continue to step backward in your actions up to your most recent **Save** command.

Use the **Redo** tool to redo your most recent action in the online classroom if you’ve changed your mind about the **Undo** command.

Place the **Pointer** tool on the whiteboard or other elements of the online classroom for emphasis.

Click **Board Background** to open a menu for customizing the whiteboard. You can set board color, choose a background pattern (dot grid, line grid, or lined), or clear the contents of the whiteboard (broom).

---

**+ (Add apps)**

Clicking on the plus sign (+) opens a menu of applications you can add to the online classroom. Table 2 describes the apps available for the online classroom.

*Table 2 Apps*

<table>
<thead>
<tr>
<th>Icon</th>
<th>App name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Board" /></td>
<td>Board</td>
<td>Opens a new board.</td>
</tr>
<tr>
<td><img src="image" alt="Drive" /></td>
<td>Drive</td>
<td>Allows you to share PPT, PDF, DOC, and audio/video files. All teachers and students have their own drive. <em>My Drive</em> is your drive for your personal files. <em>Shared</em> is a global drive with additional helpful resources.</td>
</tr>
<tr>
<td><img src="image" alt="Screen" /></td>
<td>Screen</td>
<td>Allows you to share your screen.</td>
</tr>
<tr>
<td><img src="image" alt="Google Docs" /></td>
<td>Google Docs</td>
<td>Allows you to use Google Docs for text collaboration.</td>
</tr>
<tr>
<td><img src="image" alt="YouTube" /></td>
<td>YouTube</td>
<td>Allows you to play YouTube videos synchronously. Click <strong>Share</strong> to make the YouTube video available in the online classroom. Note: Be sure that any video you share here is accessible.</td>
</tr>
<tr>
<td><img src="image" alt="Quiz" /></td>
<td>Quiz</td>
<td>Allows you to share polls, questions, and quizzes with class participants.</td>
</tr>
<tr>
<td><img src="image" alt="Image Library" /></td>
<td>Image Library</td>
<td>Allows you to share images from your own uploaded images or from the preloaded Open Images library.</td>
</tr>
<tr>
<td><img src="image" alt="Courses" /></td>
<td>Courses</td>
<td>Allows you to bring course contents onto the whiteboard/into the online classroom.</td>
</tr>
<tr>
<td><img src="image" alt="Breakout Rooms" /></td>
<td>Breakout Rooms</td>
<td>Allows you to break into groups for focused discussions.</td>
</tr>
<tr>
<td><img src="image" alt="Embed" /></td>
<td>Embed</td>
<td>Allows you to embed an external website or webpage. Note: Some websites/webpages do not allow third-party access.</td>
</tr>
<tr>
<td><img src="image" alt="Latex" /></td>
<td>Latex</td>
<td>Allows you to share latex equations. This function is for future use.</td>
</tr>
</tbody>
</table>
Live audio/video window
The live audio/video window provides face-to-face interaction with class participants. You can communicate with all participants, or directly with a single participant.

Additionally, this window has controls for:

- Muting and unmuting the microphone
- Turning the video camera ON and OFF
- Starting and stopping recording
- Adding a reaction to the live audio/video, including emojis.

Click the microphone icon to mute/unmute the live audio.

Click the camera icon to turn the video camera ON and OFF.

Click the dot to start and stop recording.

Click the reactions icon to open the reactions menu, where you can share your reactions.

Reacting to audio/video material

Use emojis to respond to material presented.

You can show your reactions to all class participants or just to the host.

You can raise your hand to ask a question.

Click Celebrate to open the Celebration menu.

In the Celebration menu:
1. Type a message in the Reward text field.
2. Select an award icon.
3. Select a praise phrase.
4. Click Send.

Chat window
The chat window provides tools for real-time chats. You can share real-time messages with the entire group or submit comments/questions directly to the session instructor/moderator.
Public chat

Click the open text bubble to chat with create and/or participate in a public chat.
1. With your cursor in the text entry field, type a message.
2. Click the send icon to share it with all session participants.

Ask a question to the host

Click the “?” text bubble to send a message to the session host.
1. With your cursor in the text entry field, type your question.
2. Click Send to send your question to the session host.

Configuration menu

The Configuration menu is anchored to the left edge of the online classroom window. Its contents allow you to fine-tune overall elements of the online classroom.

Table 3 describes functionality available in the Configuration menu.

Table 3 Configuration Menu

<table>
<thead>
<tr>
<th>Icon</th>
<th>App name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Apps" /></td>
<td>Apps</td>
<td>These are the same applications that are available by clicking the plus sign (+) in the top tab bar of the online classroom window. Refer to Table 2 Apps for complete descriptions.</td>
</tr>
<tr>
<td><img src="image" alt="People" /></td>
<td>People</td>
<td>Click People to open the People menu, which displays a list of session participants and other options.</td>
</tr>
<tr>
<td><img src="image" alt="Chat" /></td>
<td>Chat</td>
<td>This icon opens an expanded chat window with the same functionality as described in the Chat window section on the previous page.</td>
</tr>
<tr>
<td><img src="image" alt="Layout" /></td>
<td>Layout</td>
<td>The Layout icon opens the Layout menu, where you can configure the layout of the online classroom.</td>
</tr>
<tr>
<td><img src="image" alt="Settings" /></td>
<td>Settings</td>
<td>Click Settings to open the Settings menu, where you can adjust settings for media connections, whiteboards, chat, and the room.</td>
</tr>
<tr>
<td><img src="image" alt="Alerts" /></td>
<td>Alerts</td>
<td>Click Alerts to display a window listing any alert messages you may have.</td>
</tr>
<tr>
<td><img src="image" alt="Exit" /></td>
<td>Exit</td>
<td>Click the Exit icon to leave the online classroom session.</td>
</tr>
</tbody>
</table>
People
Click the **People** icon to open the **People** menu.

*Figure 6 People Menu*

In the **People** menu, you can:

- **Search** for someone by typing their name in the search bar.
- Click the blue **Add Person** icon to add another person to the session.
- See a **List** of people currently attending the session.
- If you have Host/Moderator privileges, you can **Mute** the audio for everyone, or revoke audio access for one or more people.
- If you have Host/Moderator privileges, you can **Stop all videos** for everyone, or revoke video access for one or more people.
- If you have Host/Moderator privileges, click the **Pencil** icon to revoke/enable writing access for the session.
- If you have Host/Moderator privileges, click the **Chat** icon to revoke/enable chat access for the session.

Click the **X** in the upper right corner of the **People** menu to close it and return to the online classroom.
Layout

Click the **Layout** icon to open the **Layouts** menu.

*Figure 6 Layouts Menu*

![Layouts Menu](image)

Table 4 describes functionality available in the **Layouts** menu.

*Table 4 Layouts Menu*

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Switch layout for everyone" /></td>
<td>Switch layout for everyone</td>
<td>This toggle control manages who is affected by layout change. Note: This control is only available to instructors/moderators.</td>
</tr>
<tr>
<td><img src="image" alt="Classroom" /></td>
<td>Classroom</td>
<td>This is the default layout. The classroom layout comprises a large whiteboard on the left with stacked video and chat windows on the right third of the screen.</td>
</tr>
<tr>
<td><img src="image" alt="Gallery" /></td>
<td>Gallery</td>
<td>The gallery layout comprises a grid view of all session participants.</td>
</tr>
<tr>
<td><img src="image" alt="Large Video" /></td>
<td>Large Video</td>
<td>The large video layout displays a large video of the instruct/moderator. The stacked video and chat windows on the right third of the screen are blacked out.</td>
</tr>
</tbody>
</table>
Elements of the Online Classroom Reference Guide

<table>
<thead>
<tr>
<th>Layout</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Whiteboard</td>
<td>The whiteboard layout displays only the whiteboard. The stacked video and chat windows on the right third of the screen are blacked out.</td>
</tr>
<tr>
<td>Full Screen</td>
<td>Clicking the full screen icon will stretch the current layout to cover all available screen space, including the right third of the screen.</td>
</tr>
<tr>
<td>Split Screen</td>
<td>The split screen layout displays a whiteboard on the left, and a video window on the right.</td>
</tr>
<tr>
<td>Right Panel Size</td>
<td>Use the slider control to adjust the size of the right panel in any of the two-panel layouts.</td>
</tr>
</tbody>
</table>

Note: Changes made to the Layout menu take place immediately.

Click the X in the upper right corner of the Layout menu to close it and return to the online classroom.

Settings
Click the Settings icon to open the Settings menu.

Click the X in the upper right corner of the Settings menu to close it and return to the online classroom.

*Figure 7 Settings Menu*

*Media controls*
In the Media controls area of the Settings menu, you can view the quality and resolution of the session settings, fix resolution, and open a window to change devices.
**Whiteboard controls**
In the Whiteboard controls, you can enable/disable async mode, enable/disable downloads, clear all whiteboards, and save whiteboards to a preconfigured location.

**Chat controls**
In the Chat controls, click **Popup Chat** to open a floating live chat window. Click **Clear Chat** to clear all chat windows.

**Room controls**
In the Room controls area of the settings menu, you can enable/disable the waiting room, lock/unlock the room, and add breakout rooms.

Refer to the *Creating and Using Breakout Rooms* instruction sheet for more information on breakout rooms. (future standalone document)

**Alerts**
Click **Alerts** to open a list of all alerts for this session, showing who initiated an action, what the action was, and the time the action occurred. Click the trash icon to clear all alerts.
Exit
Click the Exit icon to leave the session.

1. A dialog asking if you are sure you want to leave or end the session displays.
2. Click Cancel to dismiss the dialog and return to the online classroom
   or
   Click Leave to leave the session and return to your Intercambio Learning System (ILS) dashboard
   or
   Click End to end the session and return to your ILS dashboard (this control is only available to
   instructors and moderators).